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1.  mérés 

Súlymérés 

Mérési feladat: 

• Állítsa össze a képen látható kísérletet! 

• Határozza meg a leírás alapján a kiadott test súlyát! 

• Készítsen a mérésről az erőket feltüntető értelmező rajzot! 

Szükséges eszközök: 

1 méternél kicsit hosszabb faléc ráragasztott papír mérőszalaggal, 1 N méréshatárú dinamométer, 

akasztókampóval ellátott ismeretlen súlyú test (a test súlya meghaladja az erőmérő méréshatárát), 

támasztó ék, Bunsen-állvány 

 

A mérés leírása: 

Akassza az ismeretlen súlyú testet a léc legalább négy különböző helyére, mérje meg ezek 

távolságát az alátámasztástól és határozza meg, hogy mekkora erővel lehet a lécet az  erőmérővel 

egyensúlyban tartani! 

• Készítsen értelmező rajzot! 

• Határozza meg a test súlyát! 
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  2. mérés 

A rugóra függesztett test rezgésidejének vizsgálata 

Mérési feladat: 

• Bizonyítsa mérésekkel, hogy a harmonikus rezgőmozgás rezgésideje a tömeg 

négyzetgyökével egyenesen arányos! 

• Határozza meg a kiadott ismeretlen tömeget az alábbi leírás szerint! 

Szükséges eszközök: 

Bunsen-állvány és dió, a dióba befogható rúd a rugó rögzítéséhez, rugó, 50 g-os egységekből álló 

tömegsorozat (legalább 4 db), ismeretlen tömegű test, stopper 

 

A mérés leírása: 

Akasszon a rugóra 1-2-3-4  50 g tömegű testet, és mérje meg mindegyik tömegnél a rezgésidőt! A 

rezgésidőt 10 teljes rezgés idejéből számítsa ki! 

• Készítsen táblázatot, majd grafikusan igazolja a T√𝑚 arányosságot! 

• Akassza az ismeretlen testet a rugóra, és mérje meg a rezgésidőt! Ennek ismeretében a 

grafikon alapján határozza meg a test tömegét! 
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3. mérés 

Forgási energia mérése, tehetetlenségi nyomaték számítása  

  
Feladat:  

Állapítsa meg méréssel és számolással egy lejtőn leguruló, gördülő csődarab forgási energiáját! 

Számítsa ki a csődarab tehetetlenségi nyomatékát!  

  

  

Szükséges eszközök:  

  

Egy kb. 1-1,5 méter hosszú, nagyon kicsi emelkedésű lejtő; nagyméretű (kb. 8-10 cm átmérőjű), vékony 

falú fémcső néhány centiméteres darabja; mérőszalag; stopper; mérleg.  

  

  

A mérés leírása:  

Mérje meg a csődarab tömegét és sugarát! Győződjön meg arról, hogy a cső falvastagsága a sugarához 

viszonyítva nagyon kicsi!   

Az 1 méteren 2-3 cm-t emelkedő, kellően érdes felületű lejtőn gurítsa le kezdősebesség nélkül a 

csődarabot! Mérje meg a legördülés idejét legalább ötször, majd a lejtő hosszának, magasságának és a 

mért időtartamoknak az ismeretében, a gördülési feltétel felhasználásával végezze el az alábbi 

számításokat! Válaszoljon a kérdésekre!  
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- A mért adatok ismeretében határozza meg a cső haladó mozgásának energiáját a lejtő alján!  

- Az energiamegmaradás alapján határozza meg a cső forgási energiáját!  

- A legördülési kísérletek eredménye alapján határozza meg a csődarab tehetetlenségi nyomatékát!   

- A csődarab tömege és geometriai adatai alapján számítsa ki a csődarab tehetetlenségi 

nyomatékát!  

Határozza meg az utóbbi számítás esetén a tehetetlenségi nyomatékra vonatkozó eredményének relatív 

hibáját! Milyen tényezők okozhatták a mérés pontatlanságát? 
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4. mérés 

Tapadókorongos játékpisztoly-lövedék sebességének mérése ballisztikus ingával 

 

Mérési feladat: 

 Lője ki a tapadókorongos lövedéket az ingára, és mérje meg, hogy az ütközéskor  mennyire lendül 

hátra az inga, és mekkora az együttes lengésidejük! 

• Ballisztikus inga segítségével határozza meg a játékpisztoly-lövedék sebességét! 

 

Szükséges eszközök: 

Tapadókorongos műanyag játék pisztoly; hosszú, kettős zsineggel állványra függesztett ismert 

tömegű, bútorlapból készült inga, melyre jól tapad a tapadókorong; hurkapálca; megfelelő 

magasságú támasz, amin a hurkapálca fekszik; üvegcső, melyben a pálca akadálytalanul 

elcsúszhat; vonalzó; stopper; digitális mérleg. 

 

A mérés leírása:  

Az üvegcsövön dugja át a hurkapálcát, hogy kb. 

10 cm-t kilógjon, és éppen érintse a felfüggesztett 

bútorlap közepét! A túloldalról, 15-20 cm 

távolságból lője ki a lövedéket az ingatest 

közepére! Mérje meg a lövedék és az ingatest 

tömegét digitális mérleggel! 

• Mérje meg, hogy mennyivel tolódik hátra 

a hurkapálca! Többször mérjen, és 

számoljon átlagértékkel! Ez a távolság 

lesz a rezgés amplitúdója (A). 

• Mérje meg a lengés periódusidejét (T)! 

Célszerű 10 lengés idejéből kiszámolni a 

lengésidőt! 

• E két adat felhasználásával számolja ki a 

kilendülés sebességét! 

• Alkalmazza a rugalmatlan ütközésre az 

impulzus-megmaradás törvényét, és 

számolja ki a lövedék sebességét! 



7 
 

5. mérés 
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6. mérés 

Pattogó pingponglabda mozgásának vizsgálata Tracker videóelemző program segítségével  

  
Feladat:  

Készítsen videofelvételt egy kezdősebesség nélkül leejtett pingponglabda mozgásáról! Elemezze a 

labda mozgását Tracker videóelemző program segítségével!  

  

  

Szükséges eszközök:  

  

Pingponglabda; hosszúságetalon (pl.: hosszú vonalzó); esetleg erős lámpa; számítógép Tracker 

szoftverrel; kamera (videokamera, web-camera vagy rövid filmfelvétel készítésére is alkalmas 

fényképezőgép).  

 

A mérés leírása:  

A pingponglabda pattogását rögzítse mozgóképen a kamera segítségével! A képbe helyezze be az 

ismert hosszúságú etalont a kamera irányára merőlegesen! Ügyeljen arra, hogy a pingponglabda 

pályája minél jobban kitöltse a képmezőt, és hogy a kamera vízszintesen nézzen a pattogó labdára! 

Célszerű a labdát erős fénnyel megvilágítani és a kamerát állványon rögzíteni.  
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A filmen rögzített mozgást elemezze a Tracker program segítségével! A labdát a képkockákon 

tömegpontnak jelölve készítse el a programmal a mozgás magasság–idő, illetve függőleges sebesség–

idő grafikonját! A grafikonok segítségével válaszoljon az alábbi kérdésekre!  

Megjegyzés:  

Közvetlenül a talajra érkezés pillanata előtt és után fordulhat elő, hogy a labda képe elmosódott, ekkor 

a legnagyobb a labda sebessége. A jelenség nem okoz túl nagy pontatlanságot, ha a felvételen a 

tömegpont helyének kiválasztásakor minden képkockán a folt geometriai középpontját jelöljük meg. A 

képbe helyezett hosszúságetalon segít abban, hogy a program a távolságokat helyesen mérje fel.  

  

- Adja meg az első öt lepattanás idejét, és ezen lepattanások esetén a leérkezés és a felfelé indulás 

sebességét!  

- Milyen viszony fedezhető fel a leérkezések sebessége, illetve a hozzájuk tartozó visszapattanás 

sebessége között? Magyarázza meg ennek okát!  

- Határozza meg az első öt lepattanás után azt a sebességet, amellyel fölfelé indul a labda, illetve 

amellyel utána visszaérkezik a földre! Hasonlítsa össze és értelmezze az adatokat!  

- Elemezze az esetleges mérési pontatlanságok okait!  

  

Az ingyenes Tracker program jelenleg csak angol változatban tölthető le. Várhatóan 2017 januárjára 

elkészül a magyar nyelvű verzió is. Addig segítségül szolgálhat a felkészülésben az alábbi rövid magyar 

nyelvű leírás, mely a Tracker méréshez tartozó funkcióit mutatja be.  

  

Rövid útmutató a Tracker program használatához:  
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1. Az elkészített videófájl beolvasása a File → Import → Video menüpontokkal lehetséges.  

  

2. A videóablakban a Create → Calibration Tools → Calibration Stick segítségével létrehozhatunk egy 

„vonalzót” a videó első képkockáján, amely segít a programnak a távolságokat meghatározni. A 

vonalzót jelölő szakasz végpontjait egérrel a videóban elhelyezett hosszúságetalonhoz igazítva és a 

szakasz mellett megjelenő számértékbe az etalon hosszát beírva pontos pozícióértékeket 

kaphatunk.  

  

3. Ugyancsak a videóablakban a Create → Calibration Tools → Offset Origin menüpontok 

segítségével egy origót helyezhetünk el a képen. A program a koordinátaértékeket ettől a ponttól 

fogja számolni. Az origót szintén egérrel a képen tetszőlegesen elhelyezhetjük. (Az origót, illetve a 

hosszúságetalont később is bármikor igazíthatjuk vagy átállíthatjuk, ilyenkor a már addig 

beolvasott pozícióadatok is megváltoznak.)  

  

4. A Create → Point Mass menüpont segítségével új tömegpontot hozhatunk létre. A tömegpont 

helyét a képen Shift + egérkattintással határozhatjuk meg, ilyenkor a labda pozíciója megjelenik a 

jobb oldali táblázatban adatként, illetve a jobb felső sarokban elhelyezkedő grafikonon. A program 

a kattintásra egy képkockával automatikusan lépteti a videót, így a Shift gombot lenyomva tartva 

és az egérrel ismételten a labda közepére kattintva végig rögzíthetjük a labda mozgásának 

pozícióadatait. Az első pont elhelyezése előtt a videóablak jobb alsó sarkában található kék nyíllal 

célszerű a videót ahhoz a képkockához előreléptetni, amelyik közvetlenül megelőzi a mozgás 

kezdetét.  

  

5. Az adatokat a program automatikusan megjeleníti a jobb oldalon látható grafikonon. A grafikont a 

jobb felső sarokban lévő nyíllal nagyíthatjuk. Alapértelmezésben az x(t) grafikon jelenik meg, de a 

tengelyeken elhelyezett feliratra kattintva kiválaszthatjuk az azon a tengelyen ábrázolt adatot, így 

az y(t), illetve vy(t) grafikon szintén azonnal megkapható.  
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7. mérés 

A hang sebességének mérése állóhullámokkal 

 

Mérési feladat: 

• Határozza meg a hang levegőbeli terjedési sebességét hangvilla és vele rezonáló 

levegőoszlop segítségével! 

• Határozza meg a mérés abszolút és relatív hibáját! 

Szükséges eszközök: 

Legalább 60 cm magasságú mérőhenger, vagy egyik végén zárt műanyag cső; a csőbe illeszthető 

mindkét végén nyitott, oldalán centiméter-skálával ellátott vékonyabb műanyag cső; ismert 

frekvenciájú hangvilla; víz; tálca. 

A mérés leírása: 

Állítsa a mérőhengert a tálcára, tegye bele a 

műanyag csövet (a skála nullpontja felül legyen), 

majd töltse tele a hengert vízzel! Pendítse meg a 

hangvillát és tartsa a cső nyitott vége fölé 1-2 cm-

re! Emelje együtt felfelé a csövet és a hangvillát, és 

amikor a hang felerősödését hallja, olvassa le a 

skálán a cső vízből kiálló részének hosszát! 

Folytassa az emelést a következő rezonancia-

helyzetig, és olvassa le ismét a levegőoszlop 

hosszát! 

• Határozza meg a hang levegőbeli 

hullámhosszát két egymás utáni 

rezonancia-helyzetben! 

• Számítsa ki a hangvilla frekvenciájának 

ismeretében a hang terjedési sebességét! 
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8. mérés 

Szilárd test és folyadék sűrűségének meghatározása  

  

Feladat:  

Határozza meg az Arkhimédész-törvény segítségével a mellékelt szilárd test és az ismeretlen folyadék 

sűrűségét!  

  

  

Szükséges eszközök:  

  

Mérőpoharak; víz; digitális mérleg; rugós erőmérő; 15-20 dkg tömegű, ismeretlen, a víznél nagyobb 

sűrűségű test (pl. kődarab); cérna; cellux; ismeretlen sűrűségű folyadék (pl. étolaj).  

  

A mérés leírása:  

  

Mérje meg a rugós erőmérővel az ismeretlen sűrűségű test egyensúlyban tartásához szükséges erőt, a 

levegőben tartva a testet! Ismételje meg a mérést úgy is, hogy a test teljesen vízbe merül! Ügyeljen 

arra, hogy a test teljes egészében a vízben legyen, de ne érjen hozzá a mérőpohárhoz! A mérési 

elrendezéseket az 1. ábrán láthatja.  

 

    

                  1. ábra                                     2. ábra  
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Ezután tegyen ismeretlen sűrűségű folyadékot a másik mérőpohárba! Mérje meg a mérleggel a 

mérőpohár és az ismeretlen sűrűségű folyadék együttes tömegét! Az utóbbi mérést végezze el úgy is, 

hogy a testet az ismeretlen folyadékba lógatja! Ügyeljen arra, hogy a test teljes egészében 

belemerüljön az ismeretlen folyadékba, de ne érjen hozzá a mérőpohárhoz! A mérési elrendezéseket a 

2. ábra mutatja.  

- Jegyezze fel mindkét esetben (levegőben tartva, vízbe merítve) a rugós erőmérő által mutatott 

erő értékét!  

- Határozza meg a szilárd test sűrűségét! A levegőben fellépő felhajtóerőt tekintse 

elhanyagolhatónak a számolás során!  

- Jegyezze fel mind a három esetben (1. csak a kő; 2. mérőpohár + ismeretlen sűrűségű folyadék; 

3. mérőpohár + ismeretlen sűrűségű folyadék + kő belelógatva) a digitális mérleg által mutatott 

tömegértékeket!   

- Határozza meg az ismeretlen folyadék sűrűségét! -  Milyen tényezők befolyásolhatták a 

mérések hibáját? Elemezze a mérések hibáját!  
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9. mérés 

Szilárd anyag fajhőjének mérése 

Mérési feladat: 

• Mérje meg a kiadott fém fajhőjét a rendelkezésre álló kaloriméterrel! 

 

Szükséges eszközök: 

Apró darabokra vágott alumínium huzal, ismert hőkapacitású kaloriméter hőmérővel, keverővel, 

szobahőmérő, 2 db közepes méretű főzőpohár, meleg víz, tálca, törlőkendő, digitális mérleg. 

 

A mérés leírása: 

Mérje meg a kiadott fémdarabok 

tömegét (mf) a digitális mérleggel és 

hőmérsékletét (Tf) a szobahőmérővel! 

Mérje le a kaloriméter tömegét 

„üresen” (müresen), töltse fel kb. a 

háromnegyed részéig meleg vízzel, 

majd mérje le újra a tömeget (mvízzel)! E 

két mérésből állapítsa meg a beöntött 

víz tömegét (mv)! Tegyen hőmérőt a 

vízbe, majd néhány perc elteltével 

állapítsa meg a hőmérsékletét (Tv)! 

Rakja a vízbe a száraz, szobahőmérsékletű fémdarabokat és néhány percnyi várakozás, kevergetés 

után olvassa le a beállt közös hőmérsékletet! 

 

• A mért és megadott adatok alapján határozza meg a fém fajhőjét! 

• A mért eredményt hasonlítsa össze az alumínium fajhőjének táblázatbeli értékével! 

• Milyen tényezők okozhatják a mérési hibát? 
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10. mérés 

A kristályosodási hő mérése 

Mérési feladat:  

• Kaloriméter segítségével határozza meg a túlhűtött folyadék (sóolvadék) kristályosodási 

hőjét! 

 

Szükséges eszközök: 

Túlhűtött folyadék tasakban (kézmelegítő párna), ismert hőkapacitású kaloriméter (keverővel, 

hőmérővel), stopper, szobahőmérsékletű víz, mérőhenger, digitális mérleg. 

 

 

A mérés leírása: 

 

Mérje meg a tasakban lévő folyadék tömegét (mf)!  Töltsön a kaloriméterbe ismert mennyiségű 

szobahőmérsékletű vizet (mv)! (A víz tömege legyen kb. 6-7-szerese a tasak tömegének.)  A 

tasakban található fémlemezke átpattintásával indítsa be a kristályosodást, majd tegye a tasakot a 

kaloriméterben lévő vízbe! Helyezze bele a hőmérőt, tegye rá a tetőt és indítsa el a stoppert! 

Kevergesse a vizet, közben percenként olvassa le a hőmérsékletet amíg a melegedés tart! 

Táblázatban rögzítse a mért értékeket! 

• Ábrázolja a hőmérsékletet az idő függvényében, és állapítsa meg a rendszer maximális 

hőmérsékletét (Tmax)! 

• Határozza meg a sóolvadék kristályosodási hőjét (fagyáshőjét, Lkr)! 
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11. mérés 

Ekvipotenciális vonalak kimérése elektromos térben 

 

Mérési feladat: 

• Az alábbi kép és kapcsolási rajz alapján a megadott eszközökből állítsa össze a következő 

kísérletet! 

• Keresse meg az ekvipotenciális vonalakat a műanyag tálkában létrehozott elektromos 

mezőben! 

• Az ekvipotenciális vonalak alapján rajzolja meg a tér erővonal-szerkezetét! 

 

Szükséges eszközök: 

2 db sorba kötött lapos zsebtelep, digitális multiméter, lapos potenciálkád benne rögzített helyzetű 

elektródákkal, vezetékek, milliméterpapír, csapvíz. 

                 

A mérés leírása: 

Csatlakoztassa az elektródákra az áramforrást és  a 

voltmérőt a kapcsolási rajz szerint! Öntsön a tálba kevés 

vizet (1-2 cm magasságig)! Tegyen a tálka alá 

milliméterpapírt úgy, hogy az egyenes elektróda 

valamelyik osztásvonalra essen! Helyezze feszültség alá az 

áramkört, és a voltmérő szabad vezetékét (az ábrán nyíllal 

jelölve) az osztáspontoknál a vízbe merítve olvassa le a feszültséget! Vigye végig a vezetéket az 

elektródákat összekötő középső egyenes mentén, és az osztáspontokban (cm-enként) olvassa le a 

feszültséget! A munkafüzetben lévő milliméterpapírra rajzolja le az elrendezést, és tüntesse fel a 

megfelelő pontokban a feszültséget! 

• Keressen  a kádban az előbbi 

értékekkel azonos potenciálú 

pontokat, és rajzolja be a 

milliméterpapírra az 

ekvipotenciális vonalakat! 

• A berajzolt vonalak alapján 

vázolja az elektromos mező 

erővonal-szerkezetét! 
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12. mérés 

Elektrolit elektromos ellenállásának vizsgálata 

 

Mérési feladat: 

• Vizsgálja meg, hogy hogyan függ az elektroliton (csapvíz) átfolyó áram erőssége az 

elektródák vízbe merülésének mélységétől! 

• Határozza meg a víz fajlagos ellenállását! 

 

Szükséges eszközök: 

Váltakozó feszültségű áramforrás (0-24 V), vezetékek, az ábrán látható, vízbe meríthető rézlemez-

elektródapár zseblámpaizzóval, Bunsen-állvány, magas mérőhenger cm skálával, tálca, csapvíz. 

 

A mérés leírása: 

Kapcsoljon kb. 4 V-os feszültséget az izzóra, feszültség- és áramméréssel határozza meg az izzó 

ellenállását! Merítse vízbe az 

elektródákat, és legalább négy 

különböző mélység esetén mérje 

meg az áramerősséget (változatlan 

feszültség mellett)! 

 

 

 

 

 

• Adatai foglalja táblázatba, 

majd készítsen áramerősség-

mélység grafikont! 

• Értelmezze a kapott eredményt! 

• Határozza meg, hogyan függ a víz elektromos ellenállása a bemerülési mélységtől! 

• Ohm törvényét a folyadékok áramvezetésére is érvényesnek tekintve határozza meg a 

hideg víz fajlagos ellenállását! 
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13. mérés 

Az áramforrás paramétereinek vizsgálata 

Mérési feladat:  

• Határozza meg egy áramforrás elektromotoros erejét (U0), belső ellenállását (Rb) és 

rövidzárási áramát (Imax)! 

 

Szükséges eszközök: 

Dobozba zárt ismeretlen áramforrás, 2 db multiméter, 100 -os  tolóellenállás, vezetékek. 

 

A mérés leírása: 

Állítsa össze a következő kapcsolást! 

A tolóellenállás csuszkájának legalább 

négy különböző helyzetében olvassa le 

a kapocsfeszültséget és áramerősséget! 

 

 

 

 

 

 

• Rögzítse a mérési eredményeket 

táblázatban! 

• Készítsen kapocsfeszültség-áramerősség 

grafikont a mért adatok alapján! 

• A kapott grafikon alapján állapítsa meg az 

áramforrás jellemzőit: üresjárási feszültség, 

belső ellenállás, rövidzárási áram! 
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14. mérés 

Zseblámpaizzó ellenállásának mérése Wheatstone-híddal 

Mérési feladat: 

• Határozza meg egy zseblámpaizzó ellenállását Wheatstone-híddal! 

 

Szükséges eszközök: 

Zseblámpaizzó (3,5 V; 0,2 A), ellenállásszekrény, 1 m hosszú ellenálláshuzal a végein 

banánhüvely csatlakozással fa vonalzóra szerelve, zsebtelep, vezetékek, demonstrációs 

egyenáramú mérőműszer (Deprez-műszer). 

 

A mérés leírása: 

Állítsa össze a következő kapcsolást! 

Az ábrán Rx a zseblámpaizzó, Rs pedig az 

ellenállásszekrényből a hálózatba kapcsolt 

ellenállást jelenti. Csatlakoztassa az 

ampermérő szabad kivezetését az 

ellenálláshuzalra! Figyeljen a műszer 

méréshatárára! (A legnagyobb méréshatáron 

kezdje a mérést!) 

• A csatlakozót az ellenálláshuzalon 

csúsztatva keresse meg azt a helyet, 

ahol az ampermérő nem jelez áramot, 

majd csökkentse a méréshatárt és 

pontosítsa ezt a helyet! 

• Olvassa le ennek a helynek az A és B 

pontoktól mért távolságát ( lA, lB )! 

• Végezze el a mérést a három 

segédellenállás (5, 50, 100 ) 

bekötésével! 

• Határozza meg az izzó ellenállását mindhárom esetben! 

• Értelmezze a kapott eredményeket! 
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15. mérés 

Félvezető ellenállásának mérése, termisztoros hőmérő készítése 

 

Mérési feladat: 

• Mérésekkel határozza meg, hogy hogyan változik egy termisztor ellenállása a hőmérséklet 

függvényében! 

• Ábrázolja mérési eredményeit grafikonon! 

• Ellenállásmérés és a grafikon alapján határozza meg a két ujja közötti hőmérsékletet! 

 

Szükséges eszközök: 

1 k-os termisztor, digitális multiméter, kb. 300 ml-es főzőpohár, kisebb pohár, hideg víz, meleg 

víz, folyadékos bothőmérő. 

       

A mérés leírása: 

Töltsön forró vizet a főzőpohárba, és tegye a vízbe a 

hőmérőt! A multiméterre kapcsolt termisztort merítse a 

vízbe, majd az egyensúly beállta után olvassa le, és 

jegyezze fel a hőmérsékletet és az ellenállást! Csökkentse 

a víz hőmérsékletét úgy, hogy a meleg víz egy részét 

kiönti és hideg vizet tölt a helyébe. Ismételje meg a 

mérést egyre alacsonyabb hőmérsékleten, hogy legalább 

hat mérési eredménye legyen! 

 

 

• Mérési adatait foglalja táblázatba! 

• A táblázat alapján készítsen ellenállás-hőmérséklet grafikont! 

• Szorítsa ujjai közé a termisztort, és olvassa le az ellenállását! 

• A grafikon alapján határozza meg az ujjai hőmérsékletét! 

• Becsülje meg a termisztor  0 ºC-hoz tartozó ellenállását a grafikon alapján! 
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16. mérés 

Hagyományos izzólámpa és energiatakarékos „kompakt” lámpa relatív 

fényteljesítményének összehasonlítása 

Mérési feladat: 

• Hasonlítsa össze egy hagyományos izzólámpa és egy energiatakarékos „kompakt” lámpa 

relatív fényteljesítményét zsírfoltos fotométer segítségével! 

 

Szükséges eszközök: 

Hálózati csatlakozóval ellátott foglalatban lévő ismert névleges teljesítményű izzólámpa és 

kompakt lámpa, hálózati elosztó kapcsolóval, mérőszalag, zsírfoltos fotométer, 1 m-es műanyag 

vonalzó. 

 

A mérés leírása: 

Helyezze el a két lámpát az asztalon egymástól kb. 

1 m távolságra. Tegye közéjük a fotométert 

(bakelitlemezre ragasztott papírlap, a közepén egy 

kb. 10 Ft-os nagyságú zsírfolttal), úgy, hogy 

merőleges legyen a lámpákat összekötő egyenesre! 

Kapcsolja be a lámpákat! (Célszerű a mérést más 

fényforrásoktól − lámpa, ablak − távol elvégezni, 

hogy azok fénye ne befolyásolja az eredményt.) 

• A fotométer két lámpa közötti mozgatásával keresse meg azt a helyzetet, amikor a zsírfolt 

„eltűnik”, azaz beleolvad a környezetébe! 

• Mérje meg ekkor a fotométer távolságát a két fényforrástól (x és y )! 

• Ismerve a lámpák elektromos teljesítményfelvételét, határozza meg a relatív 

fényteljesítményeik arányát! 

Ha egy papírlapon lévő zsírfoltot visszavert fényben nézünk, akkor sötétebbnek, ha átmenő 

fényben nézünk, akkor világosabbnak látszik a környezeténél. Ha mindkét oldalról azonos 

mértékben világítjuk meg, akkor se nem világosabb, se nem sötétebb, azaz beleolvad a 

környezetébe, nem látszik. 
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   17. mérés 

A víz törésmutatójának meghatározása 

 

Mérési feladat: 

• A következő kísérleti összeállítás alapján határozza meg a víz levegőre vonatkozó 

törésmutatóját! 

• A függvénytáblázatban található értékkel összehasonlítva határozza meg a mérés abszolút 

és relatív hibáját! 

Szükséges eszközök: 

Nagyobb üvegkád, lézerpointer, milliméterpapír, Bunsen-állvány dióval a lézer rögzítésére, 

derékszögű vonalzó, víz 

A mérés leírása: 

Állítsa a kádat a milliméterpapírra! 

Állítsa mellé a Bunsen-állványt és az 

ábra szerint állítsa be a lézert úgy, hogy 

a fényfolt a milliméterpapír egy 

osztásvonalára essen! A kád lézer felőli 

oldalánál mérje meg a fénysugár 

magasságát (h) a derékszögű 

vonalzóval, majd állapítsa meg a 

milliméterpapíron a fényfolt távolságát 

(s)! Töltsön egyre több vizet a kádba, mérje a víz magasságát (y) és a fénysugár eltolódását (x)! 

 

• Magyarázza meg a fényfolt eltolódását! 

• A mérési eredményeket felhasználva határozza meg a víz levegőre vonatkozó 

törésmutatóját! 
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18. mérés 

Domború lencse fókusztávolságának meghatározása Bessel-módszerrel 

Mérési feladat: 

• Határozza meg a kiadott domború lencse fókusztávolságát az ún. Bessel-módszerrel! 

Szükséges eszközök: 

Kb. 1 m hosszú optikai pad, gyertya, gyufa, domború lencse, mérőszalag, fehér papír ernyő 

A mérés leírása: 

Az optikai pad két végére helyezze a 

gyertyát ill. az ernyőt és mérje meg 

a távolságukat (s)! 

Tegye közéjük a lencsét! Figyeljen 

arra, hogy a gyertya lángja a lencse 

közepével azonos magasságban 

legyen! 

 

• A gyertya és az ernyő helyét nem változtatva, csak a lencse mozgatásával keresse meg azt 

helyzetet, amikor az ernyőn a gyertya éles nagyított képe jelenik meg! Jelölje meg ezt a 

helyet! 

• Mozgassa a lencsét az ernyő felé, míg a láng éles kicsinyített képe jelenik meg! Jelölje meg 

ezt a helyet is! 

• Mérje meg e két hely távolságát (d)! 

• Ismételje meg a mérést még két tárgy-ernyő távolság esetén! 

• Határozza meg a lencse fókusztávolságát a következő, ún. Bessel-formula alapján 

mindhárom esetben, és számoljon átlagot! 

 

𝑓 =
(𝑠 + 𝑑) ∙ (𝑠 − 𝑑)

4𝑠
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19. mérés 

A fény hullámhosszának meghatározása optikai ráccsal 

 

Mérési feladat: 

• Mutassa be a fényelhajlás jelenségét optikai ráccsal! 

• Mérje meg a lézerfény hullámhosszát! 

Szükséges eszközök: 

Lézer fényforrás, optikai sín, optikai rács, alumíniumvonalzó (ernyő) vonalzóval, mérőszalag, 

Bunsen-állvány és dió, kémcsőfogó. 

A mérés leírása: 

Állítsa a képen látható módon rögzített 

fényforrást az optikai pad egyik 

végéhez, az ernyőt (alumínium 

vonalzó) a pad másik végére! Helyezze 

közéjük az ismert rácsállandójú optikai 

rácsot, és kapcsolja be a fényforrást! Az 

ernyőn a direkt sugárhoz képest 

szimmetrikusan jobbra ill. balra 

erősítési helyek jelennek meg. 

 

• Mérje le a rács és az ernyő távolságát (l), valamint a direkt sugár és az első elhajlási 

maximum távolságát (x)! 

• Az optikai rács rácsállandójának ismeretében határozza meg a fény hullámhosszát! 

• Ismételje meg a mérést még két különböző rács-ernyő távolság esetén, és átlagolja a kapott 

hullámhossz értékeket! 
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20. mérés 

Erőhatás távolságfüggésének kimérése neodímium mágnesek között  

Feladat:  

• Egymást taszító, neodímium mágnesek közötti erőhatás távolságfüggésének kimérése.  

Szükséges eszközök: Két darab henger alakú neodímium mágnes (például átmérő: 10 mm, magasság: 

20 mm); egy vékony, hosszú, egyik végén zárt plexicső, amelynek belső átmérője kissé nagyobb a 

mágnesek átmérőjénél; fahasáb, melynek közepén furat található (abba lehet beilleszteni a plexicsövet); 

különböző tömegű, lehetőleg ólomból vagy rézből készült hengerek, melyek beleférnek a plexicsőbe; 

műanyag vonalzó; digitális mérleg.  

A mérés leírása:  

A mérőhelyen egy olyan összeállítás áll rendelkezésére, mint 

amit a jobb oldalon látható fénykép mutat. A plexicsőben két 

neodímium mágnes található, melyek taszítják egymást. 

Óvatosan szedje szét az összeállítást, a fahasábot helyezze a 

mérlegre, majd tárázza (nullázza) a mérleget. Végül helyezze 

az egyik mágnest a fahasáb tetejére, és határozza meg a 

tömegét. (A másik mágnes maradjon a plexicsőben, és 

figyeljen arra, hogy a nagyon erős mágnesek ne csapódjanak 

egymáshoz. A tömegmérésnél a fahasábra azért van szükség, 

hogy az erős mágnes ne befolyásolhassa a mérleg 

működését.) Rakja össze az összeállítást az eredeti 

formájában. Vigyázzon arra, hogy a mágnesek taszítsák 

egymás. Mérje le a mérőhelyen lévő ólomból vagy rézből 

készült fémhengerek tömegét! Jegyezze fel az adatokat! 

Mérje meg műanyag vonalzóval a mágnesek bejelölt 

középvonalának a távolságát. Majd kezdje az ólomból vagy 

rézből készült hengerekkel felülről terhelni a felső mágnest, és minden egyes terhelésnövelésnél mérje 

le a mágnesek középvonalának a távolságát. A terhelést addig növelje, ameddig be nem telik a terhelő 

súlyokkal a plexicső. Útmutatás: Megmutatható, hogy a mágnesek között ható erő a következő alakban 

írható fel: 𝐹 = 𝐴𝑑𝑛 , ahol A egy állandó, d a középvonalak közötti távolság, n pedig egy hatványkitevő. - 

Számítsa ki a különböző terhelések esetében a mágnesek között ható F taszítóerő nagyságát newton-

egységben! Foglalja táblázatba ezeket a taszítóerőket és a hozzájuk tartozó középvonalak közötti d 

távolságot milliméter egységben! - Rajzolja fel az F–d grafikont! - Egészítse ki a táblázatot úgy, hogy 

abban szerepeljen az F erő értékének a logaritmusa, továbbá a d távolság értékének a logaritmusa! 

Bármilyen alapú logaritmust használhat, például 10-es alapú logaritmust. Ábrázolja log(F)-et log(d) 

függvényében milliméterpapíron, és a kapott pontokra minél jobban illeszkedő egyenest rajzoljon be 

vonalzóval! - Az adatokra illesztett egyenes meredekségéből határozza meg a mágnesek közötti 

taszítóerő távolságfüggésének hatványkitevőjét! 


